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[A] Getting Started 

General 

MultiTerminal is a part of the MetaTrader 4 online trading system. It is intended for: 
• managing a set of client accounts; 
• performing trade operations; 
• controlling and handling open positions and pending orders; 
• receiving quotes and news in the online mode. 

 
MultiTerminal can operate under Microsoft Windows 98SE/ME/2000/XP/2003/Vista. Hardware 
requirements are limited to software ones. 

Security System 

Data exchange between the Terminal and the server is performed by encryption based on 128-
bit keys. This is sufficient to ensure security of trading. However, besides this system, terminal 
allows to use one more system: Advanced Security system based on digital signature algorithm 
of RSA. It is an asymmetric encryption algorithm that implies presence of a public and a private 
key. Public key can be freely distributed and used for checking the authenticity of a message 
signed with a private key. Knowing of the public key is guaranteed not to be possible basis for 
decoding the private one within an acceptable period of time. Decoding of the private key on 
the basis of the public one will take tens or hundreds of years even with modern powerful 
computers. 

Attention:  

• The Advanced Security system based on electronic digital signatures can be enabled on 
the server. 

• If the Advanced Security system is enabled for a trading account, for working at another 
computer, it is necessary to transfer the generated RSA keys into this other computer. 
The keys represent files with KEY extension and are stored in the /profiles folder. 

• If either key has been lost or damaged, it is necessary to refer to the brokerage company 
technical support service. 

Live Update 

A live update system (LiveUpdate) is built into the terminal. It allows to get informed about and 
install new versions of the program promptly. This system is always enabled, it is impossible to 
disable it. 

The terminal checks for new versions of the program when it connects to the server. If a new 
version has been discovered, a new window named "Live Update" will appear, the client will be 
offered to download the update(s). To start downloading these updated files, the "Start" button 
must be pressed. The updating process and the list of files to be downloaded can be observed 
in this window. After the updates have been downloaded, the new version of the terminal will 
be automatically installed and restarted. 
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Attention:  

• If there is no connection to the server, the live updating process will not start.  
• If any problems with live updating occur, the Technical Support Service should be 

referred to.  

Terminal Settings 

MultiTerminal is generally set up in a special window that can be called by the "Tools — 
Options" menu command or using accelerating keys Ctrl+O. All settings are grouped according 
to their tasks and located in the following tabs: 

• Server — setting up parameters of connection to the server, configuring of the used 
proxy server and Data Centers, as well as other important settings; 

• Trade — parameters of opening new orders by default. They include: financial 
instrument (symbol), the amount of lots, lots allocation mode, and deviation; 

• Email — setting up email parameters. If there is a necessity to send messages by email 
directly from the terminal, the parameters of the mailbox to be used must be set up; 

• Events — setting up signals informing about system events. Signals informing about 
connection unavailability, news incomes, and others, simplify the work very much. 

Server 

Practically, the entire work of the Terminal is based on data (news and quotes) continuously 
incoming from the server. If a terminal does not receive quotes, it is impossible to trade with it. 
Server tab contains settings of the server connection. 

• Server 
It is necessary to select one of available servers from this list. 

MultiTerminal does not allow switching between the servers of different companies, 
because it is strongly bound to the servers of a certain company. 

• Data Center 
Data Centers (access points) are a part of the trading platform and represent specialized 
proxy servers. They allow to save common traffic: the same quotes and news are given 
to several terminals at the same time. Access points are located between the server and 
a terminal. One server can have several access points through which all traders will 
connect to it. After a terminal has been installed, connection to Data Centers is set up 
automatically. It is highly recommended not to change anything. Incorrect setting of 
connections to Data Centers can be the reason for no connection between the terminal 
and the server. 

If there is a necessity to change settings of Data Centers, it is recommended to contact 
Technical Support Service first. All information needed to set up Data Centers correctly 
can be obtained there. In the most cases, it is sufficient just to flag "Data Center auto 
configuration". After that, the terminal will choose the most preferable access points 
automatically. 
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For manual setting of access points, this option must be disabled. Then, in the activated 
"Data Center" field, the IP address (or domain name) and port number must be 
specified. The data must have the following format: "[Data Center internet address] : 
[port number]". The settings must be checked by pressing the "Test" button located to 
the left of this field. If settings are correct, the corresponding message will appear. After 
that, it will be possible to start working. If an error message appears, the Technical 
Support service must be contacted to solve the problem. 

Attention:  

• It is not recommended to set up access to Data Centers manually without a 
special need.  

• Proxy Server 
Connection to internet through a proxy server can be another reason for which the 
server cannot be connected to. A proxy server is an intermediate between the trader's 
computer and the trading server. It is mostly used by internet providers or by local 
networks. If a connection problem occurs, you should turn to your systems 
administrator or to the internet provider. If a proxy is used, the terminal must be set up 
in a corresponding way. Setting of "Enable proxy server" checkbox will enable proxy 
server support and activate the "Proxy..." button. Pressing of this button will open the 
window where proxy server parameters should be specified (these data can be given by 
the system administrator or by internet provider): 

o Server — proxy server address and type (HTTP, SOCKS5, or SOCKS4); 

o Login — a user login for access to the proxy server. If login is not needed, this 
field must remain empty; 

o Password — a password for access to the proxy server. If password is not 
needed, this field must remain empty. 

After the parameters have been specified, it is recommended to press the "Test" button 
to check how the settings work. If they have been tested successfully, the "OK" button 
must be pressed in order the settings to be effective. Error message means that the 
proxy server was set up incorrectly. To find out about the reasons, the system 
administrator or internet provider must be contacted again. 

• Personal data 
Terminal is intended to manage a set of client accounts. When adding accounts it is 
necessary to specify login (account number) and password. After an account has been 
added and if "Keep personal settings and data at startup" option is enabled, its password 
will be stored at the hard disk. When connecting the account to the server, this 
password will be used to connect the account automatically. If the option is disabled, a 
password must be entered manually at each connection of the account. Also, all personal 
mails, received by the internal mail system, will be deleted if option is disabled. 

• News 
Terminal allows to receive financial news promptly. They start to income just after 
connection to the server. No news issued when the terminal is disconnected will income 
in it. To enable news delivering, it is necessary to flag "Enable news". 
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Trade 

Settings used for orders opening are grouped in the Trade tab. Parameters input here facilitate 
opening of orders and cannot cause critical changes in the terminal operation. 

• Symbol by Default 
The "Symbol by default" option allows to define the symbol value when a trading 
operation is performed. The "Last used" parameter means that the symbol of the latest 
trade operation will be set automatically. For the same symbol to be set repeatedly, the 
"Default" parameter must be enabled, and the necessary symbol must be chosen from 
the list.  

• Lots by Default 
In the similar way, the initial amount of lots can be defined ("Lots by default" option): 
"Last used" is a parameter used in the previous operation, and "by default" is a 
constant, manually set value.  

• Lots Allocation 
When placing new orders, it is necessary to specify the total lots allocation for all 
accounts. The specified total lots will be distributed among accounts according to the 
specified lots allocation method: 

o Predefined volume — it will be necessary to specify manually the lots amount 
for each order when placing the order, later this predefined volume will apply at 
placing orders. 

o Total volume for each order — the total lots will apply at placing each order. 

o Equal parts — the total lots will be allocated among all orders in equal parts. 

o By equity ratio — the total lots will be allocated among orders based on the 
ratio between equities of accounts. 

o By free margin ratio — the total lots will be allocated among orders on the ratio 
between free margins of accounts. 

Attention: When the total volume is allocated between orders on accounts with 
different deposit currencies based on equity ratio or free margin ratio, the equity or free 
margin are adduced to the Summary Currency that can be chosen in the context menus 
of the Accounts panel and of the Orders or History tabs. 

The "Lots Allocation" option allows defining of the method to allocate lots among 
accounts at placing orders: "the last used value" — parameter used in the preceding 
operation, or "by default" — lots allocation method defined manually. 

• Deviation 
The symbol price can change within the ordering time. As a result, the price of the 
prepared order will not correspond with the market one, and position will not be opened. 
The "Deviation" option helps to avoid this. Maximum permissible deviation from the 
value given in the order can be specified in this field. If prices do not correspond, the 
program will modify the order by itself what allows to open a new position.  



MT4 Multi Terminal 
User Guide 

 
 

Page 6 of 25 

Email 

In the Email tab, the electronic mailbox is set up. Later on, these settings will be used to send 
message by a triggered alert. To start setting up of e-mail, the "Enable" must be enabled and 
the following fields must be filled out: 

• SMTP server — address of the SMTP server used and port. The given server will be 
used for sending messages. The entry must have the following format "[internet 
address-server address]:[port number]". For example, "192.168.0.1:443", where 
"192.168.0.1" is the server address, and "443" is the port number; 

• SMTP login — login to authorize at the mail server; 

• SMTP password — authorization password; 

• From — e-mail address from which messages will be sent; 

• To — e-mail address to which messages will be sent. 

Attention: Only one e-mail address may be specified for either of fields "From" and "To". 
Several e-mails given with or without separators will not be accepted. 

"Test" sends a test message using the settings specified to test their workability. If it has been 
tested successfully, the "OK" button must be pressed to apply these settings. If test is 
unsuccessful, it is recommended to check all settings and resend the test message. 

Events 

Signals of system events can be set up in the terminal (not to be mixed up with alerts). It is a 
very convenient tool informing about changes in the terminal status. Signals can be set up in 
this tab. For this to be done, the "Enable" option must be enabled first. At that, a table 
containing the list of system events and corresponding actions will become active. System 
events are: 

• Connect — connection to the server. Signal of successful connection to the server; 

• Disconnect — no connection to the server. Signal of interrupted connection to the 
server; 

• Email Notify — notifying about an incoming mail. If this signal has triggered, it is 
recommended to check the "Toolbox — Mailbox" window; 

• Timeout — a certain time range is predefined for performing trade operations. If this 
range has been exceeded for some reason, the operation will not be performed, and this 
signal will trigger; 

• OK — trade operation has been successfully performed. No errors occurred during 
performing of this operation; 

• News — receiving of news. If this signal has triggered, it is recommended to check the 
"Toolbox — News" window; 

• Requote — price changed during preparation of a trade operation. 
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If there is a need to disable any of the signals, it is necessary to double-click on its name or 
icon with the left mouse button. Another double click will activate it again. After the signal has 
triggered, the file specified in the "Action" field of the corresponding event will run. A double 
click on the file name allows to change the file. After double-clicking a pop-up list of available 
files to be assigned for the event will appear. Selection of any file from this list and further 
Enter button pressing means that it is assigned to the corresponding event. To confirm all 
changes made, one has to press the "OK" button.  

Attention: Any file executable in the operation system can be assigned to the event.  
 
[B] Client Accounts 

Adding Accounts 

MultiTerminal is intended for multi-account management. Accounts that can be managed using 
the terminal are listed in the "Accounts" window. If one needs to manage one more account, he 
or she must add this account into the terminal. A new account to be managed can be added 
using the "File — New Account" menu command, the corresponding button in the toolbar, or 
using the "New Account" command of the "Accounts" window context menu. 

When adding an account, it is necessary to enter login (account number) in the "New Account" 
window. The account password can also be entered. 

Attention: If the option of keeping personal details is enabled in the server settings, the 
entered password will be stored on the hard disk and used at the next connection to the server. 
Otherwise, it will be necessary to enter password manually every time when starting 
connection.  

An account can be deleted from the list of managed accounts using the "Delete Account" 
command of the "Accounts" context menu. 

Connecting Accounts 

To start managing trade accounts, it is necessary to connect them to the server. News, quotes, 
mail messages start to income in the terminal after connection, one can manage trade positions 
and place orders then. 

One can connect all accounts to the server using the "File — Connect All" menu command, the 
corresponding button in the toolbar, or the "Connect All Accounts" command of the "Accounts" 
window context menu. A separate account can be connected to the server using the "Connect 
Account" command of the "Accounts" window context menu. 

Attention: The terminal sets limitations on the amount of demo accounts connected 
simultaneously. Only 10 demo accounts from the list of managed accounts can be connected to 
the server simultaneously. As for real accounts, the maximal number of simultaneously 
connected accounts is 128.  

One can disconnect all accounts from the server using the "File — Disconnect All Accounts" 
menu command, the corresponding button in the toolbar, or the "Disconnect All Accounts" 
command of the "Accounts" window context menu. A separate account can be disconnected 
from the server using the "Disconnect Account" command of the "Accounts" window context 
menu. 
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If there are connected accounts with different deposit currencies, an additional command 
"Summary currency" appears in the context menu. It allows choosing the currency that will be 
used for the representation of the total result of all accounts, also it affects the calculation of 
the allocation of the total volume between orders when opening positions. 

Account Details 

After the account has been connected to the server, it is possible to view the account details. 
The window displaying the account details appears after selection of the "Account Details" in 
the "Accounts" window context menu or after a double click on the account. 

The "Trade" tab of this window displays the current open positions of the account, the account 
balance line and the financial results of open positions, as well as pending orders placed. All 
trade operations are displayed as a table containing the following fields (from left to right): 

• Order — the operation ticket number. This is the unique number of the trade operation; 

• Time — time when the position was opened. The record appears as YYYY.MM.DD HH:MM 
(year.month.day hour:minute). It is this time when the position was opened; 

• Type — type of the trade operation. There are some types of trade operations available: 
"Buy" — a long position, "Sell" — a short position, and pending orders Sell Stop, Sell 
Limit, Buy Stop and Buy Limit; 

• Symbol — this field shows the name of security used in a trade operation; 

• Lots — the amount of lots used in the operation. The minimum amount of lots allowed 
in operations is limited by the brokerage company, the maximum — by deposit 
available; 

• Price — open price of a position (not to be confused with the current price described 
below). It is this price at which the position was opened; 

• S/L — level of the Stop Loss order placed. If the order is not specified, zero value will 
be entered in this field. If an order was closed by Stop Loss or the distance between the 
current price and the Stop Loss level of an open order is equal to 1 point, this order field 
will be red-colored. 
One can find more details about order management in the corresponding section; 

• T/P — level of the Take Profit order placed. If the order is not specified, zero value will 
be entered in this field. If an order was closed by Take Profit or the distance between 
the current price and the Take Profit level of an open order is equal to 1 point, this order 
field will be green-colored. 
One can find more details about order management in the corresponding section; 

• Time — close time of a position. The record appears as YYYY.MM.DD HH:MM 
(year.month.day hour:minute). This field must be empty for open positions and pending 
orders placed; 

• Price — the current price of the security (not to be confused with the open price of the 
position described above) or the close price of a position; 

• Commission — fees charged by the brokerage company for trading operations made 
are written in this field; 

• Taxes — taxes charged on commission; 

• Swap — swaps are fixed in this field; 
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• Profit — the financial result of the trade considering the current price is given in this 
field. A positive value means that the trade was profitable, a negative value means that 
the trade was losing; 

• Expiration — expiration time for a pending order. This field must be empty for market 
orders and for those pending orders, for which the expiration time was not specified. 

The profit of positions can be displayed in points, in the term currency or in the deposit 
currency using the context menu commands. The account trading history can be requested 
using the "History" command of the context menu or a corresponding button. The same time 
the window in which you should specify one of the predefined periods or a concrete time range 
of the request will appear. The "Save As" context menu command and the corresponding button 
allow saving a report about the account trading as a HTML file. 

Security Tab 

The "Security" tab of the "Account Details" window allows changing the master or the investor's 
password of the account. To change a password, it is necessary to enter the current password 
of the account, its new password, then confirm the new password and press "Change".  

Open Orders 

Currently open positions and pending orders placed are displayed in the "Orders" tab. All trade 
operations are shown as a table with the following fields (from left to right): 

• Order — the operation ticket number. This is the unique number of the trade operation; 

• Login — trade account number; 

• Time — time when the position was opened. The record appears as YYYY.MM.DD HH:MM 
(year.month.day hour:minute). It is this time when the position was opened; 

• Type — type of the trade operation. There are some types of trade operations available: 
"Buy" — a long position, "Sell" — a short position, and pending orders Sell Stop, Sell 
Limit, Buy Stop and Buy Limit; 

• Symbol — this field shows the name of a security used in a trade operation; 

• Lots — the amount of lots used in the operation. The minimum amount of lots allowed 
in operations is limited by the brokerage company, the maximum — by deposit 
available; 

• Price — open price of a position (not to be confused with the current price described 
below). It is this price at which the position was opened; 

• S/L — level of the Stop Loss order placed. If the order is not specified, zero value will 
be entered in this field. If the distance between the current price and the Stop Loss level 
becomes less than or equal to 10 points, this field of the order is colored red. If the 
distance shortens to 1 point, it becomes yellow. 
One can find more details about order management in the corresponding section; 

• T/P — level of the Take Profit order placed. If the order is not specified, zero value will 
be entered in this field. If the distance between the current price and the Take Profit 
level becomes less than or equal to 10 points then this field of the order is colored 
green. If the distance shortens to 1 point, it becomes yellow. 
One can find more details about order management in the corresponding section; 
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• Price — the current price of the security (not to be confused with the open price of a 
position described above); 

• Commission — fees charged by the brokerage company for trading operations made 
are written in this field; 

• Taxes — taxes charged on commission; 

• Swap — swaps are fixed in this field; 

• Profit — the financial result of the trade considering the current price is given in this 
field. A positive value means that the trade was profitable, a negative value means that 
the trade was losing; 

• Expiration — expiration time for a pending order. This field must be empty for market 
orders and for those pending orders, for which the expiration time was not specified. 

• Comment — the order comment specified at its placing. 

The profit of positions can be displayed in points, in the term currency or in the deposit 
currency using the context menu commands. The account trading history can be requested 
using the "History" command of the context menu or a corresponding button. The "Save" 
context menu command and the corresponding button allow saving a report about the account 
trading as a HTML file. 

If there are connected accounts with different deposit currencies, an additional command 
"Summary currency" appears in the context menu. It allows choosing the currency that will be 
used for the representation of the total result of all accounts, also it affects the calculation of 
the allocation of the total volume between the orders when opening positions. 

Trade History 

The "History" tab displays closed positions and canceled pending orders of the account. All 
trade operations are displayed as a table with the following fields (from left to right): 

• Order — the operation ticket number. This is the unique number of the trade operation; 

• Login — trade account number; 

• Open Time — time when the position was opened. The record appears as YYYY.MM.DD 
HH:MM (year.month.day hour:minute). It is this time when the position was opened; 

• Type — type of the trade operation. There are some types of trade operations available: 
"Buy" — a long position, "Sell" — a short position, and pending orders Sell Stop, Sell 
Limit, Buy Stop and Buy Limit; 

• Lots — the amount of lots used in the operation. The minimum amount of lots allowed 
in operations is limited by the brokerage company, the maximum — by deposit 
available; 

• Symbol — this field shows the name of security that is used in the trade operation; 

• Price — open price of the position (not to be confused with the current price described 
below). It is this price at which the position was opened; 

• S/L — level of the Stop Loss order placed. If the order is not placed, zero value will be 
entered in this field. If an order was closed by Stop Loss, this field has a red 
background. 
One can find more details about order management in the corresponding section; 
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• T/P — level of the Take Profit order placed. If the order is not placed, zero value will be 
entered in this field. If an order was closed by Take Profit, this field has a green 
background. 
One can find more details about order management in the corresponding section; 

• Close Time — time of closing a position or time of pending order deletion. The record 
appears as YYYY.MM.DD HH:MM (year.month.day hour:minute); 

• Price — close price of the position; 

• Commission — fees charged by the brokerage company for trading operations made 
are written in this field; 

• Taxes — taxes charged on commission; 

• Swap — swaps are fixed in this field; 

• Profit — the financial result of the trade considering the current price is given in this 
field. A positive value means that the trade was profitable, a negative value means that 
the trade was losing; 

• Expiration — expiration time for a pending order. This field must be empty for market 
orders and for those pending orders, for which the expiration time was not specified. 

• Comment — the order comment specified at its placing. 

The profit of positions can be displayed in points, in the term currency or in the deposit 
currency using the context menu commands. The account trading history can be requested 
using the "History" command of the context menu or a corresponding button. The "Save " 
context menu command and the corresponding button allow saving a report about the account 
trading as a HTML file. Using the corresponding commands of the context menu, one can 
request for the accounts trading histories for various periods. The chosen period also affects 
reports that are saved using the corresponding command mentioned above. 

If there are connected accounts with different deposit currencies, an additional command 
"Summary currency" appears in the context menu. It allows choosing the currency that will be 
used for the representation of the total result of all accounts; also it affects the calculation of 
the allocation of the total volume between the orders when opening positions. 
 
[C] Trading 

Order Types 

MultiTerminal allows to prepare requests and request the broker for execution of trading 
operations. Moreover, terminal allows to control and manage open positions. For these 
purposes, several types of trading orders are used. Order is a client's commitment to brokerage 
company to perform a trade operation. The following orders are used in the terminal: Market 
order, Pending order, Stop Loss and Take Profit. 

• Market Order 
Market order is a commitment to the brokerage company to buy or sell a security at the 
current price. Execution of this order results in opening a trade position. Securities are 
bought at ASK price and sold at BID price. Stop Loss and Take Profit orders (described 
below) can be attached to a market order. Execution mode of market orders depends on 
the security traded. 
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• Pending Order 
Pending order is the client's commitment to the brokerage company to buy or sell a 
security at a pre-defined price in the future. This type of orders is used for opening a 
trade position provided the future quotes reach the pre-defined level. There are four 
types of pending orders available in the terminal: 

1. Buy Limit — buy provided the future "ASK" price is equal to the pre-defined 
value. The current price level is higher than the value of the placed order. Orders 
of this type are usually placed in anticipation of that the security price, having 
fallen to a certain level, will increase; 

2. Buy Stop — buy provided the future "ASK" price is equal to the pre-defined 
value. The current price level is lower than the value of the placed order. Orders 
of this type are usually placed in anticipation of that the security price, having 
reached a certain level, will keep on increasing; 

3. Sell Limit — sell provided the future "BID" price is equal to the pre-defined 
value. The current price level is lower than the value of the placed order. Orders 
of this type are usually placed in anticipation of that the security price, having 
increased to a certain level, will fall; 

4. Sell Stop — sell provided the future "BID" price is equal to the pre-defined 
value. The current price level is higher than the value of the placed order. Orders 
of this type are usually placed in anticipation of that the security price, having 
reached a certain level, will keep on falling. 

 

• Orders of Stop Loss and Take Profit can be attached to a pending order. After a pending 
order has triggered, its Stop Loss and Take Profit levels will be attached to the open 
position automatically. 
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• Stop Loss 
This order is used for minimizing losses if the security price has started to move in an 
unprofitable direction. If the security price reaches this level, the position will be closed 
automatically. Such orders are always attached to an open position or a pending order. 
The brokerage company can place them only together with a market or a pending order. 
Terminal checks long positions with BID price for meeting of this order provisions, and it 
does with ASK price for short positions. 

• Take Profit 
Take Profit order is intended for gaining the profit when the security price has reached a 
certain level. Execution of this order results in closing a position. It is always attached to 
an open position or a pending order. The order can be requested only together with a 
market or a pending order. Terminal checks long positions with BID price for meeting of 
this order provisions, and it does with ASK price for short positions. 

Attention:  

• execution prices for all trade operations are defined by the broker;  

• Stop Loss and Take Profit orders can only be executed for an open position, but not for 
pending orders.  

Types of Execution 

There are three order execution modes in the MultiTerminal: 

• Instant Execution 
In this mode, the order is executed at the price offered to the broker. At sending the 
order to be executed, terminal sets the current prices in the order. If a broker accepts 
the prices, the order will be executed. If not, the so-called "Requote" will occur: broker 
returns prices at which the order can be executed. 

• Execution on Request 
In this mode, the market order is executed at the price previously received from the 
broker. Prices for a certain market order are requested from the broker before the order 
is sent. After the prices are received, order execution at the given price can be either 
confirmed or rejected. 

• Execution by Market 
In this order execution mode, a broker makes a decision about the order execution price 
without any additional discussion with the trader. Sending of the order in such a mode 
means advance consent to its execution at this price. 

Attention: Execution mode for each security is defined by the brokerage company. 

Trade Orders 

New Order 

Opening of a position or entering the market is the initial buying or selling of a certain volume 
of the traded security. A position will be opened both at execution of a market order and at 
automated execution of a pending order. 
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Market Order 

Positions can be opened using the "New Order" tab. Positions for all or some of the managed 
accounts can be opened in this tab. Every connected account is represented as a table line. If 
there is no need to open positions for an account, this account line in the table must be 
unchecked. 

When opening positions, it is necessary to specify their details:  

• Symbol — the security, on which positions are being opened. 

• Stop Loss — Stop Loss order level (optional). 

• Take Profit — Take Profit order level (optional). 

Attention: Zero values of Stop Loss and Take Profit orders mean that the orders have 
not been placed at all.  

• Comment — non-obligatory comment. Its length may not exceed 25 characters. The 
brokerage company can add to the comment its own information up to 6 characters long 
or completely replace it. After the position has been opened, the comment cannot be 
changed. 

• Total Volume — total volume (total amount of lots) of trades in accounts. The total 
volume is allocated among accounts according to the preset volume allocation method. 

• Lots Allocation — method of the total volume allocation among accounts: 

o predefined volume — the predefined volume will be used at placing orders. It 
will be necessary to specify manually the lots amount for each order by double-
clicking in the "Volume" field, later this predefined volume will apply at placing 
orders. 

o total volume for each order — the total volume will be used at placing of every 
order. 

o equal parts — the total volume will be allocated among all orders in equal parts. 

o on equity ratio — the total volume will be allocated among orders according to 
the accounts equity ratio. 

o on free margin ratio — the total volume will be allocated among orders 
according to the accounts free margin ratio. 

Attention: When the total volume is allocated between orders on accounts with 
different deposit currencies based on equity ratio or free margin ratio, the equity 
or free margin are adduced to the Summary Currency that can be chosen in the 
context menus of the Accounts panel and of the Orders or History tabs. 

• Maximum deviation from quoted price — the maximum deviation value given in 
points. If the broker requotes, the new price deviation from the previously quoted price 
is calculated. If this deviation is less or equal to the preset parameter, the order will be 
executed at the new price without any further notifications. Otherwise, the broker 
returns new prices, at which the order can be executed. 

Attention: The deviation in placing orders is only used in the Instant Execution mode.  
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After all necessary data have been specified, it is necessary to press "Sell" or "Buy". The order 
to open a short or a long position, respectively, will be sent to the broker. If it is necessary, one 
can send the order to open a position for only one account by pressing the corresponding 
button in the account line. 

Attention: If the orders are executed by request for the selected security, it is necessary to 
press "Request" before the quotes start incoming. The quotes incoming after request will be 
active for only a few seconds. If no decision is made within this period of time, "Sell" and "Buy" 
will be blocked again.  

If Stop Loss and Take Profit levels were too close to the current price during opening the 
position, the message of "Invalid S/L or T/P" will appear. It is necessary to move the levels 
from the current price and re-request to place the order. The trade position will be opened after 
the brokerage company has made a trade and placed Stop Loss and Take Profit. 

Attention: If nothing happens when pressing the "Sell" or "Buy" buttons, you should check the 
correctness of the Stop Loss and Take Profit orders. For example, the order will not be placed if 
you set the value of the Stop Loss larger than Take Profit when trying to buy. 

Pending Orders 

To open a position using a pending order, it is necessary to place it as described in the "Pending 
Order" section. If the current prices comply with the order condition, the pending order will be 
executed automatically, i.e. a new trade position will be opened. If Stop Loss and Take Profit 
orders were attached to the pending order, they will be automatically attached to the newly 
opened position. 

Close Order 

Buying or selling a security opens a trade position. Then, to gain profits on bid-and-ask prices, 
it is necessary to close the position. Trade operation of closing a position is an inverse operation 
compared to the opening operation. For example, if the first trade operation was buying 1 lot of 
GOLD, one has to sell 1 lot of the same security to close the position. Positions can be closed in 
three ways: close of a single position, close of a position by an opposite position, and multiple 
close of all opposite positions. 

Closing a Single Position 

Positions can be closed manually in the "Close" tab. All or some of positions can be closed in 
this tab for all or selected managed accounts. Every connected account that has open positions 
and every open position are represented as a table line. If there is no need to close positions 
for an account, the line of this account must be unchecked in the table. If not all positions need 
to be closed, the necessary positions must be checked in the table. 

When positions of a symbol are closed in the Instant Execution mode, one can preset the 
maximum permissible deviation from the requested price. If the broker requotes, the deviation 
of the requoted price from the initially requested one is calculated. If the deviation is less or 
equal to the preset parameter, the order will be executed at the requoted price without any 
further notifications. Otherwise, the broker returns new prices, at which the order can be 
executed. 
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If it is necessary, one can send an order to close positions of only one account or to close only 
one position by pressing "Close" in the account line or in the position line. 

Attention:  

• in the mode of Request Execution, the proposed quotes will be active for only a few 
seconds. If no decision is made within this period of time, "Close" will be blocked again;  

• the terminal allows partial close of a position. For this, before pressing "Close", one has 
to specify in the "Volume" field a smaller value than that of the open position;  

• broker can close positions, too. For example, this can be done if the price reaches the 
"Stop Out" level set up by the broker.  

A single open position will be closed automatically if prices reach levels of the Stop Loss or Take 
Profit orders. 

Attention: When a long position is being closed, the Bid price must reach the stop order level 
(Stop Loss or Take Profit), for short positions - the Ask price should reach those levels.  

Close By Order 

An opposite position on the same symbol is considered as counter position to the given one. If 
there is one or more counter positions among open positions, the selected position can be 
closed by the counter one. 

Counter positions can be closed using the "Close By" tab. In this tab, one can close a position 
by a counter position for all or selected accounts managed. Each connected account, for which 
there are open counter positions, is represented as a table line. If there is no need to close 
positions for an account, this account must be unchecked in the table. The position to be closed 
must be first selected in the account line (in its popup positions list), then check a counter 
position in the list of opposite positions and press "Close". 

If counter positions have different amounts of lots, only one of them remains opened. The 
volume (the amount of lots) of this position will be the difference between volumes of positions 
just closed. The direction (short or long) and the open price of this new position will be equal to 
the greater (in volume) of positions closed. 

Multiple Close By Order 

Multiple close of several counter positions allows closing more than two counter positions for 
one symbol simultaneously. 

Several counter positions will be closed using the "Multiple Close By" tab. Counter positions for 
all or some of the managed accounts can be closed in this tab. Every connected account that 
has open counter positions and every open position are represented as table lines. If there is no 
need to close positions for an account, this account line must be unchecked in the table. To 
close counter positions for a symbol, it is necessary to press "Multiple Close By". 
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If the difference between counter positions volume sums is not equal to zero, the operation will 
result in opening a new position with the volume equal to this difference. The newly opened 
position will further participate in multiple close, but according to its open time (earlier orders 
are closed at first). And so on until either all positions are closed or the last resulting position is 
opened. 

Pending Order 

Pending orders can be placed using the "Pending" tab. Pending orders for all or some of the 
managed accounts can be placed using this tab. Every connected account is represented as a 
table line. If there is no need to place a pending order for an account, this account must be 
unchecked in the table. 

At placing pending orders, it is necessary to specify their details: 

• Symbol — the security, for which pending orders are placed. 

• Stop Loss — Stop Loss order level (optional). 

• Take Profit — Take Profit order level (optional). 

Attention: Zero values of Stop Loss and Take Profit orders mean that the orders are not 
placed at all.  

• Comment — non-obligatory comment. Its length may not exceed 25 characters. The 
brokerage company can add to the comment its own information up to 6 characters long 
or completely replace it. After the position is opened, the comment cannot be changed. 

• Total Volume — total volume (total amount of lots) of trades in accounts. The total 
volume is allocated among accounts according to the preset volume allocation method. 

• Lots Allocation — method of the total volume allocation among accounts: 

o predefined volume — the predefined volume will be used at placing orders. It 
will be necessary to specify manually the lots amount for each order by double-
clicking in the "Volume" field, later this predefined volume will apply at placing 
orders. 

o total volume for each order — the total volume will be used at placing of every 
order. 

o equal parts — the total volume will be allocated among all orders in equal parts. 

o on equity ratio — the total volume will be allocated among orders according to 
the accounts equity ratio. 

o on free margin ratio — the total volume will be allocated among orders 
according to the accounts free margin ratio. 

Attention: When the total volume is allocated between orders on accounts with 
different deposit currencies based on equity ratio or free margin ratio, the equity 
or free margin are adduced to the Summary Currency that can be chosen in the 
context menus of the Accounts panel and of the Orders or History tabs. 

• Open Price — price level, at which the order must trigger. 

• Type — type of the pending order: Buy Limit, Buy Stop, Sell Limit, or Sell Stop. 
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• Expiry — set the time period, within which the order is valid (optional). If the order 
does not trigger until this time, it will be deleted automatically. 

Attention: The expiration value may not be less than 10 minutes. 

After all necessary data have been entered, it is necessary to press "Place". A pending order 
execution is divided into two stages. After the order has been requested, the broker places it. 
At the second stage, if prices comply with the order conditions, the order will be deleted and a 
trade position will be opened instead. This open position ticket will coincide with the pending 
order ticket. If it is necessary, the pending order can be placed for only one account by pressing 
the corresponding button in the account line in the table. 

Attention:  

• Stop Loss and Take Profit orders trigger only on open positions and do not work on 
pending orders. 

• If an order is not placed when pressing the "Place" button you should check the 
correctness of the Stop Loss and Take Profit orders. For example, an order will not be 
placed if you set the value of the Stop Loss larger than Take Profit when trying to buy. 

Modify Order 

Modifying of the current position is setting new stop order levels (Stop Loss or Take Profit). For 
pending orders open price and expiration time can also be changed. Positions and pending 
orders are modified in the "Modify" tab. All or some of positions or orders can be modified in 
this tab for all or some of the managed accounts. Every connected account that has open 
positions or pending orders and every open position are represented as table lines. If there is 
no need to modify positions and orders for an account, the corresponding line in the table must 
be unchecked. If only some of positions or orders should be modified, these positions or orders 
should be checked in the table. 

When modifying orders, the fields to be changed must be checked and the new data must be 
entered: 

• Stop Loss — the level of a Stop Loss order. 

• Take Profit — the level of a Take Profit order. 

Attention: Zero values of Stop Loss and Take Profit mean that these orders were not 
placed at all.  

• Open Price — price level, at which the pending order must trigger. 

• Expiry — set the expiration time for a pending order. If the order does not trigger 
before this time, it will be deleted automatically. 

Attention: The expiration time may not be less than 10 minutes. 

If it is necessary, positions and orders can be modified for only one account, or one can modify 
only one position or order by pressing "Modify" in the account line or in the order line. 
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Attention: The "Modify" buttons will become active after you correctly specify the above 
mentioned parameters. 

If the levels of Stop Loss and Take Profit are too close to the current price during order 
modifying, the message of "Invalid S/L or T/P" will appear. The stop levels must then be moved 
from the current price and the repeated request for placing stop orders should be sent. A trade 
position will be opened after the brokerage company has executed a trade operation and placed 
Stop Loss and Take Profit. 

Delete Order 

Should the market situation change, there can be the need to delete a pending order. Pending 
orders can be deleted using the "Delete" tab. Some or all pending orders for some or all 
managed accounts can be deleted in this tab. Every connected account that has pending orders 
and every pending order are represented as table lines. If there is no need to delete pending 
orders for an account, the line of this account in the table must be unchecked. If there is a need 
to delete only some of pending orders, they must be checked in the table. 

If it is necessary, pending orders can be deleted for only one account or one can delete only 
one pending order by pressing "Delete" in the account line or the order line, respectively. 

[D] Analytics 

News 

The list of incoming news is stored in the "News" tab. The news topics are represented as a 
table and arranged according to the incoming time. The news incoming time, its topic and 
category are published in the table. This list is updated automatically at incoming of the latest 
news. 

The following commands are available in the context menu: 

• View — view selected news. One can also read news by double-click with the left mouse 
button on the topic; 

• Category — show/hide the "Category" column; 
• Auto Arrange — automatic arrangement of columns when changing a window size; 
• Grid — show/hide grid to separate columns. 

Attention:  

• If the "Enable news" option is disabled in terminal settings, news will not income.  

• If the given account has no appropriate rights, this can be one of the reasons why news 
do not income or cannot be viewed.  

Alerts 

Alerts tab contains information about created alerts. The alerts are intended for signaling about 
events in the market. Having created alerts, one may leave the monitor as the MultiTerminal 
will automatically inform about the server events. 
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All alerts in this tab are represented as a table with the following fields: 

• Symbol — security, the data on which are used to check for the condition specified. If 
the "Time=" parameter (alert triggering at the pre-defined time) was selected as a 
condition, the symbol does not matter; 

• Condition — condition under which the alert will trigger. The following can be used as 
such a condition: 

1. Bid> — the Bid price is higher than the specified value. If the current Bid price 
exceeds the given value, the alert will trigger; 

2. Bid< — the Bid price is lower than the specified value. If the current Bid price 
goes under the given value, the alert will trigger; 

3. Ask> — the Ask price is higher than the specified value. If the current Ask price 
exceeds the given value, the alert will trigger; 

4. Ask< — the Ask price is lower than the specified value. If the current Ask price 
goes under the given value, the alert will trigger; 

5. Time= — time is equal to the given value. As soon as this time comes, the alert 
will trigger. 

• Counter — the amount of alert triggerings; 

• Limit — maximum permissible amount of the alert triggerings. Having triggered this 
given amount of times, the alert will stop triggering; 

• Timeout — the period of time between alert triggerings; 

• Event — the action to be performed. This can be an audio signal, a file executable in 
operational environment, or a message sent by email. 

Alerts Management 

The following context menu commands are intended for managing alerts: 

• Create — create a new alert. The same action can be performed by pressing the Insert 
key; 

• Modify — edit the alert. The same action can be performed by double-clicking on the 
alert name in the table or by pressing the Enter key; 

• Delete — delete the alert. This action can also be performed by pressing the Delete 
key; 

• Enable / Disable — enable/disable the alert. The alert will not be deleted when 
disabled, but it stops to trigger. It can be enabled later. The same action can be 
performed by pressing the Space key or enabling in the alert setup window (described 
below). 

Attention: To manage alerts with the keyboard, one should activate this window first. To do 
so, it is necessary to click with the left mouse button in the window.  

One can start modifying an alert by double-clicking of the left mouse button in the alert 
information line. In this case, as well as at execution of the "Modify" and "Create" context menu 
commands, the alert editor window will appear: 
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• Enable — alert on/off. When the alert is off, it is not deleted, but it will stop functioning. 
This option is similar to the "Enable On/Off" context menu command and pressing of the 
Space key; 

• Action — assign an action to be performed when an event happens: play a sound, run a 
file, or send an email. 
When playing a sound or running a file, one should specify the corresponding files. At 
sending a message, one should specify the topic and text of the message; 

• Symbol — security, the values of which will be used to check the condition; 

• Condition — condition ("Time=", "Bid<", "Bid>", "Ask<", "Ask>") under which the alert 
will trigger; 

• Value — check the value of the condition. If the symbol price is equal to this value, the 
alert will trigger; 

• Source — the alert. When a sound is played or a file is run, one should specify the path 
to the corresponding file. When a message is sent by email, one should input the 
message. It must be noted that one should set up email parameters for sending 
message; 

• Timeout — the time period between alert triggerings; 

• Maximum iterations — maximum amount of times the alert triggering repeats. 

The "Test" button allows to check the usability of the selected alert. For changes to come into 
effect, one must press the "OK" button. 

Attention: To send messages about events happened, one has to set up mailbox parameters in 
the program settings.  
 
[E] User Interface 

Main Menu 

File Menu 

The File menu contains commands for managing accounts, and for printing and saving reports. 
The following commands are available in the menu: 

• Connect All — connect all account to the server; 

• Disconnect All — disconnect all accounts from the server; 

• New Account — add new account to the list of managed accounts; 

• Save — save the list of orders or accounts history; 

• Print — print the list of orders or accounts history; 

• Print Preview — preview before printing; 

• Print Setup — common print setup; 

• Exit — close the program. 
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Edit Menu 

The Edit menu contains find and copy commands. The following commands are available in the 
menu: 

• Copy — copy selected data into clipboard; 

• Find — finding a list element according to the given criterion; 

• Find Next — continue the search and find the next list element. 

View Menu 

The View menu contains commands for managing signal windows, toolbar, and the program 
interface language. Some of these commands are duplicated in the toolbar. The following 
commands are available in the menu: 

• Languages — call the sub-menu managing languages of the terminal. Having selected 
a desired language, one can switch the terminal interface to this language. For the 
changes to take effect, the program must be restarted. 

• Toolbar — show or hide the toolbar of the terminal. 

• Status Bar — show or hide a status bar located in the lower part of the terminal 
window. 

• Market Watch — open/close the "Market Watch" signal window where the current 
quotes are published. The same action can be performed by accelerating buttons of 
Ctrl+M or by pressing the corresponding button of the toolbar. 

• Accounts — open/close the "Accounts" window where the list of managed accounts is 
located. The same action can be performed by accelerating buttons of Ctrl+A or by 
pressing the corresponding button of the toolbar. 

• Toolbox — open/close the "Toolbox" window. One can manage signals in this window, 
look through the news, emails, and journal. The same action can be performed by 
accelerating buttons of Ctrl+T or by the corresponding button of the toolbar. 

• Full Screen — enable/disable the full screen mode. As soon as this option is enabled, 
toolbar and status bar will be disabled and all signal windows will be closed. The terminal 
heading, main menu, workspace remain on the screen. The repeated execution of the 
command returns the terminal to the initial appearance.  
The same action can be performed by F11 button or by the corresponding button of the 
toolbar. 

Tools Menu 

The Tools menu contains the only command to open terminal settings window. 

• Options — open the terminal setting window. One can set up parameters for 
connection, trades, emails, and events in this window. More details can be found in the 
"Terminal Settings" section. The Options window can also be called by accelerating keys 
of Ctrl+O or by a corresponding button of the toolbar. 
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Window Menu 

The Window menu contains commands for switching between order and trade windows. 

• Orders — switch to open orders window; 

• History — switch to trade history window; 

• New Order — switch to new orders window; 

• Close Order — switch to close orders window; 

• Close By — switch to close by orders window; 

• Multiple Close By — switch to multiple close by orders window; 

• Pending Order — switch to placing pending orders window; 

• Modify Order — switch to modifying orders window; 

• Delete Order — switch to deleting pending orders window; 

Help Menu 

The Help menu is auxiliary. Execution of the menu commands does not influence the terminal 
operation in any way. One can do the following from this menu: 

• Help Topics — open the built-in help files containing this present Userguide. All settings 
and functions of the MultiTerminal are described in it. F1 button performs the same 
action. 

• About... — open the "About..." window where one can find information about the 
company, its contact details, and the terminal version, as well. 

Toolbar 

The main commands used in the terminal are duplicated in the toolbar in the form of buttons. 
Normally, the toolbar is placed under the main menu, but it can easily be moved to any 
program window area. Toolbar can be shown or hidden by the "View — Toolbar" menu 
command. Toolbar is customizable, what allows placing only necessary, often used commands 
in it. To set up a toolbar, one has to open its context menu (right mouse-button click) and 
execute the "Customize..." command. 

The following commands are available in the toolbar: 

• Connect All — connect all accounts to the server; 

• Disconnect All — disconnect all accounts from the server; 

• New Account — add a new account to the list of managed accounts; 

• Save — save the list of orders or accounts history; 

• Print — print the list of orders or accounts history; 

• Print Preview — preview before printing; 

• Find — finding a list element according to the given criterion; 

• Find Next — continue the search and find the next list element. 
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• Market Watch — open/close the "Market Watch" signal window. 

• Accounts — open/close the "Accounts" window. 

• Toolbox — open/close the "Toolbox" window. 

• Full Screen — enable/disable the full screen mode. 

• Options — open the terminal setting window. 

• Help Topics — open the built-in help files containing this present "Userguide". 

Market Watch 

The securities (symbols), for which the terminal gets quotes from the server, are listed in the 
"Market Watch" window. The data are represented in this window as a table having several 
fields. The "Symbol" field contains the security name, the fields of "Bid", "Ask", and "Time" 
show the corresponding prices and time of their income from the server. Values of the 
"Maximum" and "Minimum" fields are calculated on the basis of price changes within a day. The 
"Market Watch" window can be opened/closed by pressing accelerating keys of Ctrl+M, by the 
"View — Market Watch" menu command, or by pressing the corresponding button of the 
toolbar. 

At the right mouse button click in the "Market Watch" window, the context menu will appear 
where the following commands are available: 

• Tick Chart — open the tick chart of the symbol selected. The tick chart is located 
directly in the "Market Watch" window. The tick chart of the selected symbol can also be 
viewed by switching to the tab of the same name in the same window.  

• Hide — delete (hide) the symbol from the list. To minimize the traffic, it is 
recommended to hide unused securities from the quotes window by this command or by 
pressing of the Delete button. 

Attention: If there are open positions or pending orders for the symbol, the symbol 
cannot be deleted. 

• Hide All — delete all symbols from the list. This command does not apply to securities 
for which there are open positions. 

• Show All — show the list of all available securities. After this command has been 
executed, quotes will income for all these symbols. 

• Symbols — open the window of the same name with a list of all available symbols. 
Symbols are grouped in the window according to their types. The "Show Symbol" 
command allows to add necessary symbols to the quotes window, and that of "Hide 
Symbol" — to delete a symbol from it. The "Properties" window command allows to view 
the symbol parameters (spread, digits, stops level, etc.). 

• High/Low — add the highest and the lowest values of the daily price to the quotes 
displayed.  

• Time — show time of incoming quotes. 

• Auto Arrange — automatic arranging of columns when changing the window size. Auto 
Arrange can also be enabled by pressing A button; 

• Grid — show/hide the grid separating columns. The grid can also be shown by pressing 
G button; 
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• Popup Prices — open an additional quotes window. The list of symbols in this window is 
the same as that in the "Market Watch" window at the moment of the command 
execution. This means that changes in the symbol list in the "Market Watch" window do 
not influence that in the "Popup Prices". In the context menu of this window, there are 
commands allowing to set up data displaying parameters, enable the full screen mode, 
or locate the window over all others. 

Mailbox 

The "Mailbox" is intended for working with the internal mailing system. It is in this window of 
the "Toolbox" where all messages that income to the terminal are stored. They are represented 
as a table with the following fields:  

• Time — the time of the news incoming; 

• To — the login of recipient; 

• From — the sender name; 

• Subject — the subject of the message. 

Using a double-click of the left mouse button on the necessary message or the "View" context 
menu command, one can view the content of the selected message, and one can delete a 
message using the "Delete" command. Besides, if the brokerage company permits it, one can 
send messages to the system administrator or to technical support service from this tab. To do 
so, one has to execute the "Create" context menu command, then select a receiver in the 
appearing window, head the message, write its text, and press the "Send" button. 

Attention: All messages are sent by internal mailing system and do not require any additional 
settings. If any problems occur when using the mailbox, it is recommended to refer to the 
technical support service. 

Journal 

All operations and events performed are written to special statistics journals that are 
represented as text files. The "Journal" section of the "Toolbox" window allows viewing these 
entries. The information is represented in the form of the table containing the following fields: 

• Time — the date and time of an event; 

• Message — the description of an occurred event. 

Only the current day entries are represented in the journal. In order to view earlier entries you 
should execute the "Open" command of the context menu. At the same time the folder 
containing the text files of the journal will be opened. You can copy the selected entry of the 
journal to the clipboard using the "Copy" command in the context menu. Also the context menu 
allows enabling the auto scrolling of messages (it returns you to the first message if the journal 
is updated), to enable the automatic sizing of columns and the displaying of the grid. 
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